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Welcome  
Welcome to QuickBooks financial software. Whether you’ve been running 
your business for years or are just starting out, having an organized, 
efficient way to manage your business can save you time, money, and 
a lot of frustration.

Use this Installing & Learning to Use Guide to get up and running as fast as 
possible in QuickBooks. 

In this guide, you’ll learn about:
• How to install QuickBooks and set up your company file
• Important QuickBooks terms and concepts
• How to get around QuickBooks
• Where to look for help when you have questions
• How to perform some essential tasks
• How to set up sales tax
• How to set up payroll in QuickBooks

Note: Since this guide covers multiple editions of QuickBooks, the name “QuickBooks” 
is used to refer to any of these editions. When information in this guide applies to a 
specific edition of QuickBooks, the specific edition name will be used. 

How to Use This Guide

Use this quick reference to find the information you want.

To Go to Page

Verify that your computer meets the necessary system requirements 4

Install QuickBooks 7

Convert data from other Intuit applications 11

Review the “Getting Started” checklist 12

Create and set up your company file 13

Learn how to get help if you have questions 22

Learn about essential QuickBooks tasks 31

Learn about sales tax (GST/PST) 47

Learn how set up payroll in QuickBooks 49
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Installing and Setting Up QuickBooks  
This chapter describes how to install and set up QuickBooks.

Note: If you want to convert data from Quicken or MYOB, follow the installation 
instructions on page 7 and then refer to “Bringing over data from other 
applications” on page 11.

Hardware and software requirements

Processor, memory, and disk space
QuickBooks Pro
• At least 200 MHz Intel Pentium processor (350 MHz - Intel Pentium II 

recommended) 
• At least 64 MB (128 MB recommended) of RAM
• 475 MB of disk space

QuickBooks Premier
• At least 200 MHz Intel Pentium processor (350 MHz - Intel Pentium II 

recommended) 
• At least 64 MB (128 MB recommended) of RAM
• 600 MB of disk space 

QuickBooks Premier - Industry-specific editions
• At least 200 MHz Intel Pentium processor (350 MHz - Intel Pentium II 

recommended) 
• At least 64 MB (128 MB recommended) of RAM
• 600 MB of disk space

Disk space requirements for additional software
• 70 MB for Microsoft Internet Explorer 6.0, provided on QuickBooks CD
• 9 MB for Timer 

Additional hardware and software
• Windows 98 (SE), Me, 2000, or XP operating system
• 2x CD-ROM drive
• 256-color SVGA monitor with a resolution of 800 x 600 (using Small 

Fonts in your Windows Control Panel Display settings)
• A sound card if you want to use the sound features



Installing QuickBooks

Did You Know?

Installing from a server

If your QuickBooks CD is 
mounted on a server or a 
shared CD-ROM drive, you can 
install from the CD to your own 
computer, but you cannot 
install from the CD to a remote 
computer.

Choose a location for your 
company file that all computers 
that need to use QuickBooks 
can access. You might want to 
put the company file on the 
computer of the person who 
most frequently uses 
QuickBooks. This enables that 
person to have the fastest 
access to the company file.

Improving performance in 

multi-user mode

To improve QuickBooks 
performance in multi-user 
mode, consider these tips:

• Store company files on the 
fastest or most powerful 
computer, preferably a 
dedicated server.

• Run reports during off hours.
• Refresh reports only when 

you’re ready to use or print 
them.

• Avoid keeping unnecessary 
QuickBooks windows or other 
applications open.

• Keep your company file size as 
small as possible. For 
example, you could minimize 
the number of items in lists, 
delete unused accounts, and 
periodically condense your 
company file.
Integration/Compatibility requirements
QuickBooks is compatible with the following products, which are each sold 
separately.

• If you plan to use features that integrate with Microsoft® Word or 
Microsoft Excel (such as Write Letters or exporting reports), you need 
Microsoft® Word 97, 2000, 2002, or 2003 or Microsoft® Excel 97, 
2000, 2002, or 2003. (More RAM enhances the use of these features.)

• If you want to synchronize with contact management software, you need 
either:
• Microsoft® Outlook 97, 98, 2000, or 2002

or
• Symantec ACT! version 3.08, 4.02, or Interact 2000

• Compatible with QuickBooks Customer Manager v1.0 R3 and QuickBooks 
Client Manager v1.0 R3 (available in QuickBooks Premier only)

• Business Planner functionality requires Adobe Acrobat 5.0 or 6.0
• Payroll and online features/services require Internet access with at least 

a 56 Kbps connection speed

Multi-user installation requirements
In a multi-user environment, you can have up to five users access 
QuickBooks files on a network at the same time. When setting up a multi-
user environment, each user must:

• Install the same version year of QuickBooks. For example, all users must 
have QuickBooks 2006.

• Have read/write access and create/delete rights to the directory where 
the company file is stored.

• Have a valid installation key code for each computer you want to install 
QuickBooks on. (If you purchase a Multiuser Licence from Intuit, use the 
key codes that are given to you at the time of purchase.) 

Note: The number of users who can access the company file at the same time is 
not necessarily equal to the number of licences you purchase. For example, if you 
purchase a Multiuser Licence and an additional licence for the sixth person in 
your office, only 5 of the 6 users can access the file at the same time.
5
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For peer-to-peer network users

To run QuickBooks in a peer-to-peer network environment, you must have 
Windows 98 (SE), 2000, Me or XP.

In a peer-to-peer network, 
each computer has its 
own copy of QuickBooks 
installed; however, the 
QuickBooks company file 
is located on only one 
computer, which must be 
left on.

Peer-to-peer networks do 
not use a dedicated file 
server, so a single, 
dedicated machine is not 

required for computers to share files. Thus, all the networked computers 
have the option to share their resources.

Note: Windows XP users must have at least Standard user rights, and Windows 
2000 users must have Power Users Group rights in order to write to the registry 
keys and be able to run QuickBooks.

For client-server network users

To run QuickBooks in a client-server network environment, you must have 
Windows 2000 Server or Windows Server 2003.

Client-server networks are 
networks in which at least 
one computer is dedicated 
to sharing files, printers, or 
other resources. This 
computer is usually not 
used by individuals to do 
their daily work.

For example, there might 
be three computers for 
three individual users and 
one file server. In a client-
server network, you will 
most likely put the company file on the server in a location accessible by all 
computers that need to use QuickBooks. Because all three users use 
QuickBooks, they each need to have their own copy of QuickBooks installed. 
The file server, however, does not need to have QuickBooks installed on it.

QuickBooks
installed

QuickBooks
installed

QuickBooks installed and
company file located here



Installing QuickBooks

Did You Know?

Back up your previous 

accounting system

If you have an existing business, 
make sure that you’ve backed 
up your financial records from 
your previous accounting 
system. The government 
requires you to keep this 
information for seven years. You 
should also keep any software 
and hardware that your previous 
accounting system used, or 
have printouts of all the 
information and accounting 
reports.

Record your password in a 

safe place

Be sure to write down and save 
your administrator password in 
a secure place. Passwords not 
only protect your company data, 
but are also required to access 
your company file if you 
upgrade your version of 
QuickBooks. Furthermore, to 
have a forgotten password 
removed from a file, you must 
send the file to Intuit. This 
process takes several days and 
costs money.

Passwords are case sensitive

Keep in mind that passwords 
are case sensitive in 
QuickBooks 2004 and later. 
When adding or editing a user 
password, check the Caps 
Lock and Num Lock keys. If 
you mistype the password, you 
will not be able to access the 
company data.

Troubleshoot error messages

If you receive an error message 
during installation, and 
rebooting your system does not 
resolve the problem, you can 
search for the error message on 
the QuickBooks support site at:
knowledgebase.quickbooks.ca/
Installing QuickBooks

To install QuickBooks:

Shut down all running programs, including virus protection programs.

Insert the QuickBooks Installation CD in your computer’s CD-ROM drive. 
The Installation Wizard prompts you to install QuickBooks. Click Yes.

Note: If the installer does not start automatically, click Start in the Windows 
taskbar, then choose Run. Type D:\setup.exe (where “D” is the CD-ROM drive 
letter). Click OK.

Click the Install QuickBooks 2007 button.

Type in your installation key code, and click Next.

Where can I find my installation key code? Each copy of QuickBooks has 
a unique key code number which is needed to install the software. The 
location of your key code varies depending on how you purchased 
QuickBooks. Use the list below to help you locate your key code.

If you purchased QuickBooks: 

• from a retail store, your key code is on the Installation CD;
• by calling Intuit directly, your key code is on the packing slip, in an 

email (if you gave one to the sales representative), or you may have 
received it over the phone; or

• from our Web site, your key code is on the Web receipt.

Follow the on-screen instructions to complete the installation.

Once QuickBooks is installed, you can start QuickBooks by double-clicking 
the QuickBooks icon on the desktop, or by choosing QuickBooks from the 
Programs group on the Windows Start menu.

What do I do if I’m upgrading from an earlier version of QuickBooks?

If you are upgrading from QuickBooks 2004 or later, you don’t need to do 
anything more. You are ready to use your new software. 

If you are upgrading from QuickBooks 2003 or earlier, you must update your 
company file after installing QuickBooks 2006. For instructions on how to 
update your company file, refer to the in-product help. In the Follow-Me 
Help, go to the Find window and search for “Updating Company Files”.

Tip  After you have installed QuickBooks, write down your installation 
key code in the space provided on the inside of the front cover. You will 
need your key code if you have to re-install QuickBooks.
7
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Setting up a multi-user environment
To set up a multi-user environment and add new users:

Make sure you have your computers properly networked. Refer to your 
networking software documentation for instructions.

Install QuickBooks on each computer, as described in “Installing 
QuickBooks”.

Have your QuickBooks Administrator add and set up each user. The 
Administrator defines which features each user can access.

a. From the Company menu, choose Set Up Users.

b. Click Add User.

c. Assign a user name and case-sensitive password and click Next.

d. Follow the on-screen instructions to define the access permissions for 
the user.

Activate each copy of QuickBooks, as described in “Activating 
QuickBooks” on page 18.

As your business grows, you might need to add more computers to your 
network. For each new computer, you will need to install and activate a new 
copy of QuickBooks.

Why are passwords important?

Passwords limit access to your company file. To open a password-protected 
file, each person must enter his or her user name and a unique secret 
password. Defining users and passwords help prevent unwanted people 
from accessing your company's confidential data.

Unless you password-protect your Administrator user, anyone who can 
access the company file will have full access rights. For this reason, 
QuickBooks enables you to add users with specific access permissions. By 
defining users and their access rights, you not only control who can open 
your company file, but also what data they can view and tasks they can 
perform.

Updating your copy of QuickBooks
From time to time, Intuit provides updates to QuickBooks that can be 
downloaded from the Internet. These updates might include new features, 
services, maintenance fixes, or new help information. You can choose to 
update QuickBooks automatically or manually.

For complete instructions on updating your software, refer to the in-product 
Help. Go the Find window and search for “Updating QuickBooks”.



Installing QuickBooks

Did You Know?

Using multiple company files

If you have more than one 
company file (i.e., you are 
tracking two different 
businesses in QuickBooks), 
you should keep those 
company files in the same 
directory. That way, when you 
update QuickBooks (via a 
software update for example), 
you will need to download the 
update files only once.

Product Information Window

The Product Information 
window lists information about 
your software such as the 
number of entries you have in 
your lists, the size of your 
company file, which version of 
QuickBooks you are running, 
and the location of your 
company file. You can open the 
Product Information window by 
pressing the CTRL and 1 keys, 
or pressing the F2 button.

Using a Dell computer?

When installing an update to a 
Dell computer, you may get a 
message to shut down 
QuickBooks and try again. This 
is because Dell computers 
have a support process 
running in the background and 
it is interfering with the 
QuickBooks update agent. For 
more information on this, visit 
our support site (see below), 
and search for “support.exe”.

Troubleshoot error messages

If you receive an error 
message during installation 
and rebooting your system 
does not resolve the problem, 
you can search for the error 
message on the QuickBooks 
support site at:
knowledgebase.quickbooks.ca/
Troubleshooting

What should I do if I have trouble installing QuickBooks?

Verify that your system meets the minimum requirements listed on page 4.

Restart your computer.

Close all open programs, including virus protection programs:
• In Windows 98, press CTRL+ALT+DELETE to display the Close Program 

window. Close all programs except Explorer and Systray. If a program 
will not close or prompts you to reboot the computer, leave it open.

• In Windows 2000 or XP, select the Applications tab from the Task 
Manager (Task List) and close all open programs.

Try installing QuickBooks again.

If you need further installation assistance, 

• visit our Web site at http://knowledgebase.quickbooks.ca 
and search for install, or 

• contact our Product Support at 1 877 772 9158 
(Monday - Friday, 8 a.m. - 8 p.m. Eastern Time).

What should I do if I have trouble activating QuickBooks?

Make sure that you activate your software with a company file open.

Check that your computer system date is set properly. If the date is set 
too far ahead, QuickBooks may think that your licence is expired.
• To change your computer date in Windows, double-click the time that is 

displayed on your Windows Task Bar. 

Make sure that the person who is activating QuickBooks has 
Administrator rights in Windows, or is a user that has full-access rights.

If you need further installation assistance, contact our Product Support at 
1 877 772 9158 (Monday - Friday, 8 a.m. - 8 p.m. Eastern Time).

What should I do if I can’t find my installation key code?

Use the table on page 7 to help find your installation key code. If you cannot 
find your installation key code, but you have QuickBooks 2006 installed and 
can access it, you can find you installation key code (IKC) as follows:

Start QuickBooks 2006. 

From the Help menu, choose My Licence Information. Write down your 
Installation Key numbers on the inside of the front cover of this guide to 
keep for future reference.

If you are still unable to locate your installation key code, you can call 1 888 
333 8580. Another IKC can be given, but proof of purchase will be required.
9
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Why doesn’t my old administrator password work after I upgrade?

QuickBooks 2004 and later verions support case-sensitive passwords. If 
you believe you are entering the correct password, but are still getting the 
message “The password you typed is incorrect,” your password might 
include mixed-cased characters. Try the following:
• Attempt to log in by entering the login name of Admin, and then click OK 

without typing a password.
• Enter your password with Caps Lock or Num Lock turned on or off.
• Enter variations of your password, using mixed upper- and lower-case 

characters.
• Enter the password with a space before or after the actual password.
• Type the password in a text editor such as Microsoft® Word to confirm 

that your keyboard is functioning properly.
• Restore a pre-update backup of your file that does not have the case-

sensitive password. When you restore this file, you can set your new 
administrator password at the end of the update process.

If you are still unable to access your file, you can call 1 877 772 9158. A 
fee may be charged for this service depending on the support options of 
your service plan.

Can I install different versions of QuickBooks on the same computer?

Yes. You can install multiple versions of QuickBooks (for example 
QuickBooks 2005 and QuickBooks 2006) on the same computer. However, 
you cannot run two instances of QuickBooks from the same version at the 
same time.

Can I revert to an earlier version of QuickBooks?

Yes. Uninstall the version of QuickBooks that you don’t want, and then 
reinstall the earlier version of QuickBooks. Remember that you will not be 
able to open company files that you have converted to QuickBooks 2006 in 
earlier versions of QuickBooks.

Can I install QuickBooks (single-user version) on more than one computer?

You can install QuickBooks (single-user version) on the computers used by 
a single individual. For example, if you bought one copy of QuickBooks for 
your office, you can install it on your home PC or laptop as well. This does 
not violate the software licence agreement as long as you are the only 
person using QuickBooks on both computers. However, if multiple users will 
be accessing QuickBooks on multiple computers, then you (or your 
company) must purchase an additional licenced copy for each user.
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Did You Know?

QuickBooks backup file

The QuickBooks backup file is 
a compressed version of your 
QuickBooks company file that 
contains all transactions up to 
the date the company backup 
was made. QuickBooks 
backups have a .QBB extension 
and cannot be opened directly. 
Backups must be restored, 
using the Restore function 
located under the File menu.

To learn more about backing 
up your company file, refer to 
the in-product Help. In the 
Follow-me Help, go to Find 
window and search for 
“backing up your data”. For 
information on Follow-me Help, 
refer to “Using Follow-Me 
Help” on page 23.

Converting from MYOB

Before you import your MYOB 
data in to QuickBooks, make 
sure you have processed your 
year-end routine, and you have 
optimized and verified your 
MYOB data file. QuickBooks 
only converts MYOB data that 
has been closed as a result of 
the year-end process. 

Troubleshooting conversion 

errors

If you receive an error 
message during installation 
and rebooting your system 
does not resolve the problem, 
you can search for the error 
message on the QuickBooks 
support site at:
knowledgebase.quickbooks.ca/
Bringing over data from other applications

If you need to copy over financial data from another accounting application 
(such as Simply, Quicken or MYOB), refer to the instructions below.

Simply Accounting
QuickBooks can import your business data directly from Simply. You can 
then customize your new QuickBooks company file to your liking and begin 
using it right away.

Start Simply Accounting and open the data file you want to import into 
QuickBooks. Leave Simply running.

Start QuickBooks. From the File menu, select Import, then Simply 
Accounting. (You must have an empty QuickBooks company file open, so 
QuickBooks creates one now.)

Enter a name for your new company as well as an address and other 
basic information. This “empty” company file will receive the newly-
imported information from Simply Accounting.

Follow the on-screen instructions.

To learn more about importing data from Simply Accounting, refer to the 
in-product Help. In the Follow-Me Help, go to the Find window and search for 
“import from Simply”.

Quicken and MYOB
QuickBooks doesn’t import data directly from Quicken and MYOB, but rather 
converts it. Converting files is not difficult, but does require you to prepare 
the file properly. We have provided detailed instructions about converting 
Quicken and MYOB files to QuickBooks files in the QuickBooks User Guide. 

Note: You cannot create a new QuickBooks company file and then import your 
Quicken or MYOB data into it as is the case with Simply Accounting.

To view the conversion instructions in the User Guide:

Start QuickBooks and from the Help menu, choose Guides, then 
QuickBooks User Guide.

In the Bookmarks tab on the left hand side of the window, click the  to 
expand the “Importing and Exporting data” section of the User Guide.

Note: If your Quicken or MYOB file is ready to be converted, you can convert it by 
choosing File | Import | Convert from Quicken or Convert from MYOB from the 
menu bar.
11
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Setting Up Your Company in QuickBooks

The first thing you need to do in QuickBooks is set up a company file for 
your business. Setting up your company file properly is the most important 
thing you can do to help yourself manage your business efficiently and with 
confidence.

The setup process is easy. Depending on the complexity of your business, 
setting up your company file can take anywhere from a few minutes to a few 
hours. The amount of time varies based on how much detail you add about 
your accounts, customers, vendors, employees, products, and services, as 
well as the number of historical transactions you want to enter.

When you set up your company file, QuickBooks will prompt you for a 
number of details about your company. Before you begin the setup process, 
gather the information shown in the Getting Started Checklist below.

Getting Started Checklist

Company name
and address

You’ll need both the casual and legal name for your 
company. The legal company name is the name you use 
when filing the taxes for your business. The casual 
company name is the name that you want to appear on 
invoices, statements, reports, etc. 

Business Number 
(BN)

The 15-digit account number issued to you by the Canada 
Revenue Agency (CRA). Not all businesses need a BN. You 
need one if you collect sales tax, have employees, or your 
business is incorporated. You can obtain a BN by 
submitting Form RC1 (call 1 800 959 5525 to locate the 
closest tax service office to your home or business) or 
visiting CRA’s Web site: www.cra-arc.gc.ca

Sales Tax 
Information

The sales tax rate you charge, what you charge it on and 
how much sales tax you owe as of your start date.

Start Date

QuickBooks uses a start date as the point at which you 
begin entering your business transactions. You must enter 
all historical transactions between your start date and today 
to ensure complete accounting records for your business.

Many business owners base their accounting records on 
their fiscal year, so that they can see transactions for the 
entire year. If this is not important to you, you can choose a 
different starting point, such as today or the first of the 
month, quarter, or year.

Table continued on next page...
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Key Terms

Company file

The company file is the data 
file that QuickBooks uses to 
store and manage all the 
information and financial 
transactions for your business. 
QuickBooks company files 
have the extension .QBW.

Historical transactions

A list of all business 
transactions that happened 
before your start date. In 
QuickBooks, you can have 
many different lists of 
historical transactions, 
including:

• Invoices
• Customer payments
• Deposits
• Credit Memos
• Sales Receipts
• Bills
• Payments to vendors
• Credits with vendors
• Item receipts
• Journal entries
• Purchase orders

Assets

Company assets are the things 
that your company owns. 
QuickBooks distinguishes 
between two types of assets:

Current assets: assets that you 
are likely to convert to cash 
within one year (such as the 
cash you have on hand, the 
money in your chequing and 
savings accounts, and the 
money your customers owe 
you).

Fixed assets: assets that you 
do not expect to convert to 
cash within one year. A fixed 
asset is usually something you 
use to run your business (such 
as a truck, cash register, or 
computer).
Set up your company file
After you have gathered the company information listed in the Getting 
Started Checklist, you can set up your business in QuickBooks using the 
EasyStep Interview. The EasyStep Interview walks you through the setup 
procedure and helps you tailor QuickBooks for your business. The setup 
interview is divided into sections, so you can save your progress and return 
at a later time.

Note: In some industry-specific editions of QuickBooks Premier (for example, 
Contractor Edition), you can use a predefined company file as the starting point 
for setting up your business in QuickBooks. The predefined company file provides 
a tailored chart of accounts, an item list of products and services that you might 
most likely provide, and custom reports applicable to your industry. Using a 
predefined company file will get you up and running quickly, but you will still need 
to enter some information that is specific to your business.

Setting up your company file using the EasyStep Interview

To set up your company file:

Start QuickBooks by double-clicking the QuickBooks icon on the 
desktop, or by choosing QuickBooks from the Programs group on the 
Windows Start menu.

Click “Create a new company”, or from the File menu choose New 
Company.

Note: If the “Create a new company” window appears, you have an industry-
specific edition of QuickBooks. Turn to the instructions on page 14 instead of 
following these instructions.

The Welcome screen for the EasyStep Interview is displayed. Follow the 
on-screen instructions and complete the interview.

Bank Statements, 
Credit Card 
Accounts, and 
Outstanding 
Cheques

You need to have your latest bank statement balances and 
information about any outstanding cheques, deposits, 
withdrawals, or charges to all of the accounts you want to 
set up and manage in QuickBooks, including credit cards, 
bank accounts, lines of credit, and loans.

Optional 
Information

Eventually, you will need to enter detailed information about 
your customers, vendors, and employees, as well as the 
products and services you sell, the products that you hold 
in inventory, and any additional assets.

Getting Started Checklist (Continued)
13
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Setting up your company file using a predefined company file 
(available only in industry-specific editions)

To set up your company using a predefined company file:

Start QuickBooks by double-clicking the QuickBooks icon on the 
desktop, or by choosing QuickBooks from the Programs group on the 
Windows Start menu.

Click “Create a new company”, or from the File menu, choose New 
Company.

In the “Create a new company” window, select a predefined company 
file from the list and click OK.

In the File name field, enter a file name and click OK. QuickBooks opens 
your company file. 

After you’ve created your company file, you can begin using QuickBooks to 
run your business. But before you do, we recommend that you review the 
information in “Completing your company setup” to make sure your 
company file is properly set up and that your data is complete.

Tip  Complete the sections in the General tab before completing the 
sections in the other tabs. QuickBooks won’t know enough about your 
company to ask the rest of the Interview questions unless you fill in 
your basic company information first. Furthermore, Intuit recommends 
that you do not skip the interview process. The more information you 
enter with the EasyStep Interview, the more accurate your company file 
will be when you begin to use QuickBooks for your business. If you 
need to leave the interview and come back later, you can choose 
EasyStep Interview from the File menu to return to the interview.

Tip  During the EasyStep Interview, you will be prompted to map your 
accounts to specific tax lines for your tax forms. Intuit recommends 
that you do this, as it will make your tax preparation much easier. 
Check with your accountant if you have questions about which tax 
forms you should use and which tax lines to map to each account.

Tip  If you use Microsoft Outlook or Symantec ACT!, you can import 
your existing customer and vendor information into QuickBooks instead 
of entering it manually. Refer to the QuickBooks in-product Help for 
instructions on how to prepare your customer and vendor data file for 
importing into QuickBooks. When you are ready to import your 
customers, refer to the instructions on page 17.
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Some types of businesses 
prefer to organize their 
accounts by number. Adding 
numbers can help you identify 
the type of accounts, thereby 
speeding up your account 
selection on various forms. 
You might want to develop and 
follow a consistent account 
naming and numbering 
convention.

For example:

1000-1999 - Assets
2000-2999 - Liabilities 
3000-3999 - Equity
4000-4999 - Income
5000-5999 - Expenses
6000-6999 - Other income
and expenses

Do you live outside of 

Quebec?

If you do not live in Quebec, do 
not answer “yes” if 
QuickBooks askes whether 
you are required to send 
information to the Ministerie 
de Revenue. Answering yes to 
this question turns on the 
Audit Trail feature in 
QuickBooks, and cannot be 
turned off as this is a 
requirement for people who 
operate a small business in 
Quebec.
Completing your company setup
This section describes some additional tasks you might need to do as you 
begin using QuickBooks. 

Note: Depending on how much information you entered during the EasyStep 
Interview, some of these tasks might not apply to you.

Determine your start date

Do this task if you did not enter a start date during the EasyStep Interview.

You need to set a start date before you begin using your company file in 
QuickBooks. QuickBooks uses a start date as the point at which you begin 
entering your business transactions. You must enter all transactions 
between your start date and today to ensure complete and accurate 
accounting records for your business.

Many business owners base their accounting records on their fiscal year so 
that they can see transactions for the entire year. If this is not important to 
you, you can choose a different starting point, such as today or the first of 
the month, quarter, or year.

To enter a start date, create a balance sheet account (described on 
page 35) and enter the opening balance as of a specific date.

Enter your company information

Do this task if you used a predefined company file or did not enter this 
information in the EasyStep Interview.

To enter the contact and legal information for your company, choose 
Company Information from the Company menu. To learn more about each of 
the fields and where the information you enter will be used in QuickBooks, 
click the Help button.

Create (fine tune) your accounts

Do this task if you used a predefined company file or did not enter this 
information in the EasyStep Interview.

If you used a predefined company file or the EasyStep Interview, a chart of 
accounts was set up for you. Review the chart of accounts to be sure it 
accurately reflects the accounts you need to run your business. You can 
change account names and edit, delete, or add accounts as necessary.

To view your chart of accounts, from the Lists menu, choose Chart of 
Accounts.
15
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Complete your customer, vendor, and items lists

In order to bill customers and pay your bills with QuickBooks, you must update 
your customer, vendor, and item lists so that it accurately reflects your 
business. Instructions for setting up your customers, vendors and items are 
provided in Chapter 4.

You can choose to enter this information all at once, or you can enter it as 
you work, using the Quick Add feature, described on page 29.

Enter historical transactions

If your start date is before today's date, you'll need to enter past 
transactions from the start date to today. This ensures that your 
QuickBooks records will be completely up-to-date and reports will be 
accurate.

Enter historical transactions in chronological order. For example, 
QuickBooks won't know how to credit a customer payment unless you've 
previously recorded the invoice to that customer.

Note: Entering historical transactions is especially important if customers don’t 
pay you at the time they receive goods or services. If you don’t enter historical 
transactions early on, it’s hard to track and collect late customer payments.

Intuit recommends that you enter your transactions in this order:

• Invoices or statements you've sent out since your start date
• Purchase orders you've issued since your start date that you haven't 

received in full
• Cash or cheques you've received since your start date
• Bills you've received since your start date
• Bills you've paid since your start date
• Deposits you've made to any of your accounts since your start date
• Any other cheques you've written (for things other than bills) since your 

start date

Note: If you don't have time to enter all your historical transactions right away, 
don't worry. You don't need to enter all your past transactions before you start 
using QuickBooks for new transactions. Enter new transactions as they occur, 
then catch up with historical transactions when you can. Remember, though, that 
your account balances will be incorrect (and your reports may be wrong) until you 
enter all the past transactions.

Complete your bank account information

After you've entered your historical transactions, your account registers will 
contain entries reflecting bills you've paid, cheques you've written, and 
deposits you've received. To make your account registers complete, you 
must also enter these transactions:
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Opening Bank Balance

If you used an accounting 
program before using 
QuickBooks and you are now 
transferring data from that 
program in to QuickBooks, 
make sure the opening 
balance for your new bank 
account in QuickBooks is 
based on your bank statement 
and not the bank balance from 
your previous accounting 
software. 

The balance of the bank 
account from your previous 
accounting software will not 
include post-dated 
transactions or transactions 
that the bank has cleared.
• Cheques or other charges that happened before your start date but didn't 
appear on statements before your start date (i.e., didn’t clear)

• Other cheques you wrote after your start date that were not for bills or 
accounts payable (for example, credit card payments)

• Deposits you made after your start date that were not customer deposits
• Deposits you made before your start date, but which didn't appear on 

statements before your start date
• Bank charges and fees
• Interest paid on your account

Refer to the in-product Help for step-by-step instructions on how to enter 
these transactions to make your account registers accurate.

Synchronizing with Microsoft Outlook or Symantec ACT!

If you use ACT! 3.08, 4.02 or Interact ACT! 2000 or Microsoft Outlook 97, 
98, 2000, 2002, or 2003 you can synchronize your contact manager with 
QuickBooks and transfer all your customer and vendor information 
(including address and phone) to QuickBooks. 

Note: Intuit recommends synchronizing your customer and vendor information 
before you enter any customers or vendors manually.

To synchronize your customer and/or vendor information:

From the Company menu, choose Synchronize Contacts.

Note: If you are synchronizing for the first time, we recommend that you back 
up both the data in your contact manager and your QuickBooks company file 
before you synchronize.

Follow the onscreen instructions. You might be asked to resolve 
conflicts between your QuickBooks and contact manager data, assign 
uncategorized names to QuickBooks lists, or create alternative entries 
for duplicate names. If you need assistance with any of these tasks, 
click Help.

When the Confirm Changes screen appears, review the list of changes 
and click Accept to apply the changes.

Enter any optional adjustments

After you've created your company file, you might need to make a few 
adjustments as of your start date. You might need to:
• Enter any sales tax liability, such as GST you owe that was not part of the 

historical transactions that you entered
• Adjust the Uncategorized Income and Uncategorized Expense accounts 

(for accrual basis only)
• Adjust for current income and expenses if your start date is not at the 

beginning of the fiscal year
• Distribute earnings and equity before your start date
17
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Refer to the in-product Help for step-by-step instructions on how to enter 
these optional adjustments.

If you are unsure whether you need to enter these optional adjustments, 
check with your accountant.

Activating QuickBooks

The second time you open QuickBooks, you will be asked to activate your 
software. Activation is a process that validates you as a licenced user of 
QuickBooks. It also entitles you to online benefits and helps to prevent 
unauthorized copying of your software.

You have up to 10 uses before you have to activate QuickBooks. After your 
10th use, the activation wizard chooses a method by which it wants you to 
activate (Internet or phone). If activating by the Internet, simply follow the 
instructions in the wizard (ensure you are connected to the Internet before 
you begin activation). If activating by phone, our support staff will help you 
activate. You can call our activation line at 1 888 333 8580, Monday – 
Friday from 9 a.m. – 8 p.m. (Eastern Time).

Note: If you’re using several copies of QuickBooks, you must activate each copy 
separately.

To activate QuickBooks:

From the File menu, select Activate QuickBooks.

Click Next to start the activation process, and follow the on-screen 
instructions.

During activation, your licence information (licence key) is sent to Intuit. 
After we verify your licence key, QuickBooks is activated and available for 
your use. 

Note: Activation does not collect, transmit, or use any personally identifiable 
information.

Next steps

After you’ve installed QuickBooks, set up your company file and activated 
your software as described in this chapter, you should:

• Learn how to use QuickBooks and get answers to your questions 
(see Chapter 3).

• Learn how to perform some essential QuickBooks tasks (see Chapter 4).
• Learn how to set up QuickBooks payroll (see Chapter 5).
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The icon bar provides one-click 
access to the QuickBooks 
features that you use most

The Navigators pane lists all 
the available navigators. To 
open a navigator, click the 
name from the list

Use the Open Windows list to 
switch between open windows

The Follow-me Help tracks 
your moves and displays help 
topics that are related to what 
you are doing

Use the Find window to search 
our in-product Help and the 
FAQs on our Support site to 
get answers to your questions
Getting Around QuickBooks
The QuickBooks work area, shown in Figure 1, is designed to enable you to 
complete tasks quickly. QuickBooks provides several ways for you to work; 
choose the method that works best for you.

Figure 1. The QuickBooks work area

Using the navigators to move around QuickBooks
The navigators can help you find tasks and information related to the major 
areas of QuickBooks. To open a navigator:

• In the Navigator list, click the name of the navigator you want to open. If 
you don't see the Navigator list on the left side of the QuickBooks work 
area, go to the View menu and select Navigator List.

or

• Choose a specific navigator from the appropriate menu. For example, go 
to the Customers menu and select Customer Navigator.

The menu bar provides easy 
access to all QuickBooks tasks, 
features and reporting functions

Navigators offer quick access to tasks and 
information related to major QuickBooks 
areas. Navigators contain clickable flow 
charts, related activities, and memorized 
reports for the feature area.
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Customizing the desktop

You can modify the way that 
the QuickBooks desktop 
behaves and looks to suit your 
working style. To modify the 
QuickBooks desktop, choose 
Customize Desktop from the 
View menu.

Too many windows open?

If your QuickBooks work area 
becomes too cluttered with 
windows that you have open, 
you can close them all at once 
instead of closing them one at 
a time. To close all your open 
windows, go to the Window 
menu, and select Close All.

When you close down 
QuickBooks, it’s good practise 
to close all windows that you 
have open on your QuickBooks 
desktop. This is because 
whenever you open your 
company file, QuickBooks will 
attempt to open all the 
windows that you had open the 
last time QuickBooks was 
closed. So, if you want to save 
some time when opening your 
company file, close down all 
your windows before shutting 
down your software. 

To open your company file with 
no windows open on the 
QuickBooks desktop, hold 
down the Alt key while your 
company file is opening. 
Displaying one window at a time or multiple windows
QuickBooks is preset to show only one window at a time. By displaying one 
window at a time at its full size QuickBooks gives you more room to work on 
the task at hand. If you want to see more than one window—for example, to 
compare related reports side by side or to tile all of the open windows—
choose Multiple Windows from the View menu. You can resize and move the 
windows as needed.

Figure 2. Comparing windows side by side

Adding icons to the Icon Bar
For quick access to the areas of QuickBooks you use most, you can 
customize the Icon Bar by adding the features and reports that you use 
most frequently. Think of the Icon Bar as a shortcut to QuickBooks windows.

Note: Some QuickBooks windows cannot be added to the Icon bar.

Figure 3. Adding a feature to the Icon Bar

You can add, rearrange, and remove items from the Icon Bar to suit your 
needs. To modify the Icon Bar from its current setting, choose Customize 
Icon Bar from the View menu.

When you display 
multiple windows, 
you can see all the 
windows that you 
have open. 

This is useful when 
performing a task 
that spans over 
many windows.

To add a shortcut to a 
QuickBooks window, open 
the window, then go to the 
View menu and choose the 
“Add to Icon Bar” option.
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Getting Answers to Your Questions
QuickBooks provides a variety of tools and resources to help you find 
answers to questions you might have when using QuickBooks. Available 
resources include:

• QuickBooks Learning Center
• In-product Help 
• Additional self-help tools
• Assisted support
• Professional Advisors

Check out the QuickBooks Learning Center
As you begin using QuickBooks, one of the first things you’ll see is the 
QuickBooks Learning Center. The Learning Center provides interactive 
tutorials to help you learn how to use QuickBooks and complete common 
business tasks. After watching the video tutorials, you can follow the step-
by-step instructions available in the in-product Help. You also have access 
to all our guides from the Learning Center.

If you decide to use the QuickBooks Learning Center later, you can open it 
by choosing Learning Center from the Help menu.
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Moving your help window

You can move your Follow-Me 
Help window anywhere you like 
by clicking in the grey area at 
the top of the “Find” or 
“Follow-Me Help” window and 
dragging it to the position you 
want. When you drag a help 
window back to its original 
position in the sidebar area, it 
will automatically “snap” back 
in to position. 

Stopping Follow-Me Help

You can stop Follow-Me Help 
from tracking your activities. 
Say, for example, you are 
reading a lengthy help topic 
that requires you to open 
several windows for a given 
task, but you would rather the 
help window remain on the 
main help topic instead of 
displaying help topics for every 
subsequent window you open. 
To stop the help window from 
following what you are doing, 
click the Pin button at the top 
of the help window. 

Closing the Follow-Me Help

You can customize 
QuickBooks to open certain 
windows when your company 
file is opened. Say, for 
example, you want to keep the 
Follow-Me Help windows 
closed. To do this, first you 
must close Follow-Me Help 
(from the View menu, select 
Follow-Me Help; if there is no 
checkmark beside the Follow-
Me Help menu, then your help 
is already closed). Then go to 
the View menu and select 
Customize Desktop. Select the 
“Save current desktop” option. 
The next time you open 
QuickBooks, the Follow-Me 
Help windows will not appear.
Using the In-product Help system
QuickBooks in-product Help is an extensive system that provides 
background information and step-by-step instructions for doing every 
QuickBooks task. The Help system contains 

• Follow-Me Help
• Tools for helping you find information
• How Do I menus

Using Follow-Me Help

QuickBooks Follow-Me Help is a “smart” HTML-based help system. The 
Follow-Me Help window follows you as you work in QuickBooks and displays 
topics that are related to what you are doing. For example, if you have an 
invoice open, the Follow-Me Help automatically displays information on 
creating invoices. You no longer have to seek the information yourself.

The Follow-Me Help window is open and displayed on the left side, at the 
bottom of the QuickBooks work area. If you close this window, you can open 
it again by going to the Help menu and selecting Follow-Me Help. You can 
also open the Follow-Me Help from the View menu. 

Figure 4. The QuickBooks Follow-me Help window

Note: Some help topics are too large to be displayed in the Follow-Me Help 
window. Larger topics are opened in a separate full-sized help window. 

The  symbol means 
that there is information 
hidden. Click this symbol 
to display the information.

This is a list of topics 
related to the currently 
displayed help topic. 
Clicking a link with a  
symbol displays text 
beneath the link. Clicking 
a link that has no symbol 
takes you to a completely 
different help topic.

Use the Back and Next 
buttons to move through 
the topics you’ve visited.

Use the Index and Search buttons to 
help find topics for a specific term or 
concept. The Index and Search tools 
are opened in the Find window.

Use the Pin button to stop 
the Follow-Me Help from 
following your activities.
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Using the Index and Search tools to find information (Find window)

QuickBooks in-product Help is quite extensive. Sometimes the easiest way 
to find the Help information you need is to use the Search or Index.

To find information using the Index:

From the Help menu, choose Index, or go to the Follow-Me Help window 
and click the  (Index) symbol. The Index is displayed in the Find 
window. 
Enter a term in the blank field. The index will scroll to display the 
available entries.
Click the index entry that best describes the help topic that you want to 
see. The help topic is displayed in the Follow-Me Help window. 

To find information using Search:

• Type your question in the Ask field in the title bar of most QuickBooks 
windows and click Ask.

or

• From the Follow-Me Help window, click the  (Search) symbol. The 
Search tool is opened in the Find window. Type your question in the Ask 
field, and click Ask.

Getting step-by-step instructions

Throughout QuickBooks you’ll find windows that have a “How Do I” button 
at the top. Clicking this button provides quick access to instructions for 
tasks that are associated with the window.

Type your question here to search 
the in-product help system.
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Using Search Effectively

Entering questions of 
3-10 words produce better 
search results than simple 
keywords. For example, 
instead of typing “invoices”, 
type “How do I create 
invoices?” in the search field.

Questions should be as 
specific as possible. They 
should not get too long or 
contain too many keywords. 
For example, “How do I add 
customers?” will return better 
results than “How do I add 
new customers and vendors?”

If you get no search results, 
check the spelling in your 
question. QuickBooks knows 
about some common 
misspellings, but other 
misspellings will not be 
caught. Do not use 
abbreviations. Try different 
keywords.

Sample company files

QuickBooks includes several 
sample company files that you 
can practice with to enter 
pretend data, run reports, and 
explore QuickBooks features.

To open a sample company 
file, choose Open Company 
from the File menu and then 
choose a sample company file 
from the list.
Additional Self-Help Tools
If you cannot find the answer you want in the in-product Help, try these other 
information resources.

Using the Frequently Asked Questions Knowledge Base 
(knowledgebase.quickbooks.ca)

The QuickBooks Frequently Asked Questions (FAQs) knowledge base on our 
Support site provides a free library of articles and tips for QuickBooks.

To find information on the QuickBooks FAQ knowledge base:

In the Follow-Me Help, go to the Find window. If the Find window isn’t 
visible, go to the View menu and select Follow-Me Help.
Click the Look Online button at the top of the Find window. 

Enter a term in the blank field and click Search. The Help system opens 
a browser window and begins searching the FAQ knowledge base on our 
support site.

Articles that match the term you entered are displayed. Click the article 
that best describes the information you want to see. 

QuickBooks Support Site (www.quickbooks.ca/support)

From the QuickBooks Support Web site, you can:

• Find additional troubleshooting tips
• Submit product suggestions and report software defects
• Learn about training resources
• Find a Certified QuickBooks ProAdvisor to help you with your accounting 

needs
• Download product updates
• Get additional answers in the User-to-user forum

To display the QuickBooks Support site, from the Help menu, choose 
QuickBooks Online and then select Support.

Click Look Online to search our 
FAQ knowledge base online.

Click Search to search 
for information in the in-
product Help system.

You must be 
connected to the 
Internet to look 
at the FAQ 
knowledge base.
25
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Get Assisted Support
If you cannot find the answer you want using the in-product Help or other 
self-help tools, you can always get assisted support.

Intuit Contact Information

QuickBooks Product Support.  You can speak to a QuickBooks Product 
Expert by calling 1 877 772 9158 (Monday - Friday, 8 a.m. - 8 p.m. 
Eastern Time). Product support or membership fees may apply.

QuickBooks Sales and Service.  If you have billing or service inquiries, call 
Intuit Canada at 1 888 333 8580 (Monday - Friday, 9 a.m. - 8 p.m. 
Eastern Time).

Free Consultation Call

You receive one free consultation call which is valid for 60 days from the 
date you purchased QuickBooks. With this free consultation call, you get 
help, up front, when you need it the most to get your business up and 
running in QuickBooks. Call QuickBooks Product Support for more details.

QuickBooks Support Plans

QuickBooks Support Plans offer extended access to the QuickBooks 
Product Support experts who can help you get more out of the software and 
increase your productivity. There are two types of support plans:
• Pay-per-incident: using this method, you pay for each call that you make 

to QuickBooks Product Support
• Unlimited support plans: you subscribe to these plans which offer 

unlimited telephone support for you and your employees, email support, 
live-chat support, and priority service ; payroll support plans are also 
available

To learn more about QuickBooks Support Plans, call 1 888 333 8580.

Working with a Certified QuickBooks Professional Advisor

From time to time, you might need advice that is very specific to your 
business situation. In this case, you’ll want to contact your accountant or 
another specialized professional.

If you do not have a professional advisor, you can find a Certified 
QuickBooks ProAdvisor in your area using the QuickBooks ProAdvisor 
Referral Database. QuickBooks Professional Advisors are independent 
accountants, bookkeepers, computer consultants, and trainers who work 
with small businesses every day. They can offer guidance on everything 
from business planning to tax advice.

To find a ProAdvisor in your area, open a web browser and enter the URL: 
http://www.findadvisor.intuitadvisor.ca
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Re-sorting your lists

By default, when you add 
entries to a list in QuickBooks, 
QuickBooks keeps entries of 
the same type together. If you 
prefer to have the entries in 
your lists ordered 
alphabetically, you can re-sort 
them. 

The following lists can be 
re-sorted alphabetically. 

• Chart of Accounts
• Class
• Customer:Job
• Customer Type
• Item
• Job Type
• Memorized Transactions
• Vendor Type

To re-sort list entries 
alphabetically, open the list 
you want to alphabetize and 
click the Name column at the 
top of the window. 

QuickBooks re-sorts the 
entries alphabetically. 

To return the entries back to 
their original order, select 
Re-sort List from the menu 
button at the bottom of the list 
window.
QuickBooks Basics

To take full advantage of QuickBooks, there are some important concepts 
you need to understand.

How QuickBooks Lists Work
Lists are one of the important building blocks that make QuickBooks so 
powerful and efficient. You use information stored in lists to fill out most 
QuickBooks forms. For example, to create an invoice, you choose the 
customer name from your Customer:Job list. QuickBooks automatically 
enters the customer information on the form for you. This saves you time 
and prevents typing errors. You can also change the information directly on 
the form as needed.

Lists are easy to set up in QuickBooks, but do require careful planning. 
Each list you create has its own List window. Important QuickBooks lists 
include:

• Chart of Accounts
• Item
• Customer:Job
• Vendor
• Employee

To view a QuickBooks list, choose the list you want from the Lists menu.

To enter information in these lists, use the menu button at the bottom of 
the list to add, edit, or delete list items. The list menu also provides access 
to common features associated with the list.

The more detail you enter for each list item, the more information 
QuickBooks can use to pre-populate forms, track financial data, and display 
useful reports about your business. Another advantage of lists is that 
common tasks like adding list entries, editing list information, and deleting 
list entries are performed the same way.

Figure 5 illustrates how QuickBooks uses list information across multiple 
windows and tasks to simplify data entry and give you a complete picture of 
how your business is doing.
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What happens when I record 

a bill payment?

If you paid by:

Cheque. QuickBooks prepares 
one cheque for each vendor 
and records the cheques in 
the cheque register with 
BILLPMT in the Type field. 

Credit card. QuickBooks 
records a charge for each 
vendor in your credit card 
register. 

Cash. QuickBooks records a 
payment for each vendor in 
your cash account register. 

In each scenario, QuickBooks 
records the payment to each 
vendor in the accounts payable 
register. The amount you paid 
appears in the Payment 
column.

Key Term

Accounts Payable

The accounts payable register 
lists in date order all the bills, 
payments, and credits related 
to your vendors. You can enter 
new bills and payments 
directly into the register and 
quickly open any transaction 
listed.
Entering list information as you work

There are two basic methods you can use to enter list information in 
QuickBooks. You can enter account, customer, vendor, product and service 
information before you enter transactions in QuickBooks, or you can enter 
this information “on the fly” as you use the product. 

If you prefer to enter information as you use QuickBooks to perform your 
daily tasks, QuickBooks will prompt you to immediately set up any entry it 
does not know about. For example, if you try to create an invoice for a 
customer named Tracey Stewart and you have not entered information 
about Tracey Stewart into QuickBooks, QuickBooks will prompt you:

Clicking QuickAdd creates a new customer list entry for Tracey Stewart in 
the Customer:Job list and adds all the information you enter about the 
customer on the invoice form (billing address, payment terms, etc.) to her 
customer record.

Clicking Set Up takes you to another window where you can enter 
information not covered by the invoice. For example, you could click Set Up 
to enter Tracey Stewart’s phone number, fax number, and credit limit. 

Note: If you choose Quick Add, you can always add more information to the 
customer's record at a later time.

Writing Cheques versus Paying Bills
In QuickBooks, you can manage and pay your bills in two ways: 

Pay bills as soon as you receive them.  Use the Write Cheques window 
and assign the amounts to appropriate expense accounts. 

Wait to pay bills until they are due.  Enter bills into your accounts payable 
account and set up QuickBooks to remind you to pay bills when they are 
due. Using this method, you keep your money in your business for as long 
as possible. You might still use a cheque to pay the bill, but this method 
enables you to track how much money you owe. And at any time, you can 
run reports to analyze unpaid bills for information such as which vendors 
you owe money to. 

Figure 6 illustrates the difference between writing cheques as soon as you 
get a bill and using the accounts payable register to track and pay bills.
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Figure 6. Two methods of receiving and paying a bill from a vendor

Note: Do not simply write a cheque in the Write Cheques window to pay bills that 
you entered in the accounts payable register or the Enter Bills window. Use the 
Pay Bills window to pay these bills. When you use the Pay Bills window, 
QuickBooks will write the cheque for you automatically. Furthermore, if you do not 
use the Pay Bills window, you will have outstanding debts listed in your accounts 
payable register, so reports that you run will list items that you’ve already paid, 
and you might mistakenly pay the same bill twice.

new pic

Write Cheques Now
Enter Bills Now,
Pay When Due

Receive Bill from Vendor

WRITE CHECKS

Gallion MasonryVendor

Discount Date

Terms Ref. No.

Amount Due

Bill Due

Net 30

Bill

Date 07/14/2004

08/13/2004

1,550.00

Pay to the Order of Gallion Masonry

One thousand five hundred fifty and 00/100* * * * * * * * * * * * * * * * * * * * * * * * * *

Address

Memo

No. 302

1,550.00$

Dollars

Date 07/14/2004

Gallion Masonry
189 Old Bayshore Rd
Bayshore CA 94326

ENTER BILLS

x

Previous Next Find History Journal

Gallion MasonryVendor

Discount Date

Terms Ref. No.

Amount Due

Bill Due

Net 30

Bill

Memo

Expenses $1,550.00 Items $0.00

Memo Customer:JobAccount

Job Expenses: Job Materials 1,550.00

Amount

ClearClear Splits Recalculate Save & Close

Ask How Do I?Enter Bills

Bill Received

Date 07/14/2004

08/13/2004

1,550.00

Bill Credit

Save & New

x

Select Bills to be Paid

Show Bills
Due on or before

Show all bills Sort Bills By Due Date

Date Due

05/31/2007

05/31/2007

Kershaw Compu...

Kershaw Compu...

13,000.00

6,500.00

0.00

6,500.00

6,500.000.000.0019,500.00Totals

0.00

0.00

0.00

0.00

Vendor Ref. No. Disc. Date

Discount & Credit Information for Highlighted Bill
Vendor

Bill Ref. No.

Payment Account

Clear Selections

Checking Check

Payment Method

To be printed

Payment Date

Assign check no.

TermsKershaw Computer Se...

Sugg. Discount

Number of Credits

Total Credits Available

Amt. Due Disc. Used Credits Used Amt. To Pay

07/24/2007

07/14/2004

Pay Bills

ClearPay & Close Pay & New

Ending Balance

0.00

Net 30

0.00

0

678.06

Go to Bill Set Discount Set Credits

Ask How Do I?

x

Previous Next Print Find Journal

Pay to the Order of Gallion Masonry

One thousand five hundred fifty and 00/100* * * * * * * * * * * * * * * * * * * * * * * * * *

Address

Memo

Expenses $1,550.00 Items $0.00 Online Payment To be printed

Memo Customer:JobAccount

Job Expenses: Job Materials 1,550.00 Baker, Chris

Amount

No. 302

1,550.00$

Dollars

ClearClear Splits Recalculate Save & Close

7,178.06

Type a help question Ask How Do I?Write Checks - Checking

Bank Account Ending Balance

Date 07/14/2004

Checking

Save & New

Gallion Masonry
189 Old Bayshore Rd
Bayshore CA 94326

Pay Vendor

Print cheques or make
an online payment

Pay Bills

Enter BillsWrite Cheques

Type a help question

Type a help question
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Set Personal and 
Company preferences 
for each QuickBooks 
area

Choose a group from 
the preference list to 
set behaviour for this 
QuickBooks area

Choose the General 
option to set general 
QuickBooks 
preferences
Preferences: Modify QuickBooks for the way you work
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Did You Know?

Company preferences

Company preferences are 
global preferences that affect 
all users of the company file. 
Only the QuickBooks 
Administrator can set up or 
modify company preferences. 

Learn More

To learn more on customizing 
QuickBooks, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Setting preferences
Turning features on and off
Customize QuickBooks 

desktop

What if the Find window is 

not visible? 

The Find window is part of the 
in-product Help system. If you 
closed the Find window, you 
can open it again by going to 
the View menu and selecting 
Follow-Me Help. The Find 
window opens, by default, in 
the left hand side of the 
QuickBooks work area.
Customizing QuickBooks for the way 
you like to work

QuickBooks uses preferences to customize QuickBooks to suit the needs of 
your business and your personal style of working. From the QuickBooks 
Preferences window, you can define preferences in over a dozen different 
areas.

For example, you can configure general preferences such as whether or not 
QuickBooks prompts you before editing or deleting a transaction, or which 
date QuickBooks uses for new transactions. Or, you can configure 
accounting-specific preferences such as how QuickBooks displays accounts 
and subaccounts or whether to use features like the audit trail, sales tax, 
and multicurrency.

To view and set preference options:

From the Edit menu, choose Preferences. 

In the Preferences window, change any of the general QuickBooks 
preferences. These preferences determine how QuickBooks behaves.

Use the scroll box on the left to display the preferences for another area 
of QuickBooks. For example, to set preferences for jobs and estimates, 
select Jobs & Estimates. 

On the My Preferences tab for the particular feature area, enter the 
changes and settings that you want. These settings affect only your 
QuickBooks sessions, not those of other users.

Do one of the following: 
• Click OK to save your changes and close the Preferences window. 
• Click another feature area in the scroll box to enter other preferences.

Click OK.
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Chart of Accounts list 
shows the balance of 
each balance sheet 
account for your business

Rearrange your accounts 
by clicking and dragging the 
diamond to the left of an 
account to a new position

From the Account menu 
button, you can create new 
accounts or perform tasks 
with existing accounts

QuickBooks supports 15 
different types of accounts

Click here to make the 
account a subaccount of 
another account

Enter an opening balance 
for the account (for 
balance sheet accounts)

If you use pre-printed 
cheques, set up 
QuickBooks to remind you 
when to order cheques for 
an account
Chart of Accounts

New Account
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Key Terms

Accounts

There are two types of 
accounts: balance sheet 
accounts (such as chequing 
and savings), and accounts 
used to group transactions for 
reporting purposes (such as 
income and expense 
accounts). If you use Quicken, 
income and expense accounts 
are the same as “categories”. 
Refer to pages 36 and 37 for a 
description of the different 
QuickBooks accounts.

Chart of Accounts

A complete list of your 
business' accounts and their 
balances. You use a chart of 
accounts to track how much 
money your company has, how 
much money it owes, how 
much money is coming in, and 
how much is going out.

Did You Know?

Intuit recommends associating 
your income and expense 
accounts with the appropriate 
tax lines on your tax forms. 
Consult with your accountant if 
you need more information 
about which tax forms to use 
and to which tax lines to map 
each account.

If you do not see the Tax Line 
field when you create a new 
account, go to the Company 
menu, select Company 
Information, and from the 
Income Tax Form Used field, 
select the tax form that you 
use to file your business 
taxes. Now you should see the 
Tax Line field when you go to 
create new accounts.
Adding an Account

When you set up your company file, QuickBooks sets up certain accounts 
for you automatically. However, as your business grows or changes, you 
might need to add new accounts to your chart of accounts to better 
organize your finances. Or, you might need an account that was not provided 
during setup. For example, you might want to create expense accounts to 
track office supply purchases separately from advertising costs.

To add an account:

From the Lists menu, choose Chart of Accounts.

From the Account menu button, click New.

In the New Account window, choose the type of account from the Type 
drop-down list.

Note: Refer to pages 36 and 37 for a description of the different types of income, 
expense, and balance sheet accounts.

Enter the account’s name in the Name field. This name will appear on all 
your company financial statements.

If you want to make this account a subaccount of another account, 
select the “Subaccount of” checkbox. From the drop-down list, select 
the account that will be the higher-level account for this subaccount.

(Optional), enter a short description, note, bank account number, or 
credit card number, depending on the type of account you are adding.

For income and expense accounts. From the Tax Line drop-down list, 
choose the appropriate tax line or <Not tax-related>.

For balance sheet accounts. Enter an opening balance based on the 
account’s balance as of your QuickBooks start date. If you’re not sure of 
the balance, you can leave the field blank and enter the information 
later.

Click OK.

Why Use Subaccounts
When you need more detail about what’s going on in an account, you can 
divide the account into one or more subaccounts. Subaccounts let you track 
several related types of income or expenses independently yet keep them 
all under the “umbrella” of a single parent account. Subaccounts appear 
indented immediately below their parent account in your Chart of Accounts.

For example, if your business has substantial advertising expenses, you 
might decide to divide your Advertising expense account into several 
subaccounts, such as Newspaper Ads, Signs, Yellow Pages Listing, and 
Direct Mailings.
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For a Brand New Account

When you create a brand new account, leave the opening balance at zero. 
Its opening balance will be created automatically when you transfer funds 
from another account.

What type of account should I use?

There are two main types of accounts in the QuickBooks chart of accounts:

• Balance sheet accounts
• Income and expense accounts
Balance Sheet Accounts

QuickBooks provides ten types of balance sheet accounts to choose 
from as you create and add to your chart of accounts. Use the type 
of account that best describes the type of data you are tracking.

Use this account To track

Bank

Chequing, savings, and money market accounts. Add 
one bank account for every account your company has 
at a bank or other financial institution. (You can also 
use this type for petty cash.)

Accounts receivable 
(A/R)

Transactions related to the customers that owe you 
money, including invoices, payments, deposits of 
payments, refunds, credit memos, and statements. 
Most companies have only one A/R account.

Other current asset

Assets that are likely to be converted to cash or used 
up within one year, such as petty cash, notes 
receivable due within a year, prepaid expenses, and 
security deposits.

Fixed asset
Depreciable assets your company owns that aren't 
likely to be converted into cash within a year, such as 
equipment, furniture or a building.

Other asset
Any asset that is neither a current asset nor a fixed 
asset, such as long-term notes receivable.

Accounts payable 
(A/P)

Transactions related to money you owe, including bills, 
bill payments, and any credit you have with vendors. 
See also current and long-term liability accounts.
Table continued on next page...
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Did You Know?

Adding additional accounts

You can also add accounts as 
you perform your everyday 
tasks. For example, if you are 
writing a cheque and enter an 
account name that has not yet 
been set up in QuickBooks, 
QuickBooks will prompt you to 
set up the new account.

If you need to change your 
account information, select 
the account in the Chart of 
Accounts list and from the 
Accounts menu button, click 
Credit card Credit card purchases, bills, and payments.

Other Current liability
Liabilities that are scheduled to be paid within one 
year, such as sales tax, payroll taxes, accrued or 
deferred salaries, and short-term loans.

Long-term liability
Liabilities such as loans or mortgages scheduled to 
be paid over periods longer than one year.

Equity
Owner's equity, including capital investment, owner’s 
draws, and retained earnings.

Use this account To track
Edit.

Undeposited Funds account

The Undeposited Funds 
account is automatically added 
to your Chart of Accounts the 
first time you receive a payment 
from an invoice or sales 
receipt. This account is used to 
hold the money until you 
deposit it into a bank account. 
For more information on 
Undeposited Funds, search for 
“how does undeposited funds 
work” in the Find window.

Learn More

To learn more on managing 
your accounts, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Understanding the chart of 
accounts

Adding accounts
Changing accounts
Adding subaccounts
Income and Expense Accounts

Income and expense accounts track the sources of your income and 
the purpose of each expense. When you record transactions in one 
of your balance sheet accounts, you usually assign the amount of 
the transaction to one or more income or expense accounts. For 
example, not only do you record that you took money out of your 
chequing account, but you keep track of what you spent the money 
on (utilities or office supplies).

Use this account To track

Income The main source of money coming into your company.

Other income
Money received for something other than normal 
business operations, such as interest income.

Expense Money that is leaving your company.

Other expense
Money spent on something other than normal 
business operations, such as corporate taxes.

Cost of Goods Sold The cost of items that you sell.
Using account tax lines
Reconciling with your 

financial statement
How to use registers
Editing a transaction
Voiding or deleting a 
Note: QuickBooks does not display balances for income and expense accounts in 
the chart of accounts. To see these balances, select the income or expense 
account in the chart of accounts and from the Reports menu button, click 
QuickReport.
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The Balance column 
displays the amount of 
money each customer 
currently owes you

Double-click in the Notes 
column to add or view 
notes about a customer

From the Customer:Job 
menu button, you can 
create new customers or 
manage existing ones

Enter the customer’s 
name, address and 
contact information in the 
Address Info tab

Click Define Fields to 
create any custom fields 
that you need for your 
customers

Use the Additional Info 
and Payment Info tabs to 
set up customer payment 
terms and sales tax 
information
Customer:Job List

New Customer: Additional Info & Payment Info
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Key Term

Customers

Customers are the people or 
businesses to whom you sell 
your products or services, that 
is, the people who pay you for 
what you do. Some 
businesses might refer to a 
customer as a client or 
member.

Did You Know?

Adding jobs

If you are performing more 
than one job for a customer, 
you can track the jobs 
individually by adding new jobs 
under the Customer's name in 
the Customer:Job list. That 
way, you can create reports 
that show the income and 
expenses for each job.

Learn More

To learn more on managing 
your customers, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Adding customers
Editing a list entry 
Removing entries from lists
Setting up multiple jobs
Setting up payment terms
Setting up sales tax for 

customers
What if a customer is also a 

vendor?

About contact management 
synchronization

Editing a transaction
Voiding or deleting a 

transaction
Adding Customers

Customers are the lifeline of your business. By entering detailed information 
in QuickBooks about the people and companies to whom you sell your 
products and services, you can personalize their bills, send invoices easily, 
and quickly view the status of their accounts. You can add new customers 
at any time.

To add a customer:

From the Lists menu, choose Customer:Job List.

From the Customer:Job menu button, click New.

In the Address Info tab, enter all the data that you have about the 
customer, including his or her name, billing and shipping addresses, and 
additional contact information.

Complete the Additional Info and Payment Info tabs, as appropriate.

If you want to add additional fields to the form, click Define Fields to 
customize the form.

Click OK or Next (if you want to enter another customer).

Tip  Typing in customer data for hundreds of customers can be a 
tedious task. If you use Microsoft Outlook or Symantec ACT!, you can 
synchronize your customer data with QuickBooks instead of entering it 
manually. For instructions on importing your customer data, go to the 
Find window and search for the following help topic: “about contact 
management synchronization”. When you are ready to import your 
customers, refer to the instructions on Page 17.

Tip  You can also add customers as you perform your everyday tasks. 
For example, if you enter the name of a new customer when filling out 
an invoice, QuickBooks will prompt you to enter information about this 
customer. You can choose from two quick setup options:

• QuickAdd—Adds just the name to the list without disrupting what you 
are doing. You must add the customer’s details later.

• Set Up—Opens the New Customer window so you can set up all of 
the customer’s details in the Customer:Job List.
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The Balance column 
shows how much money 
you currently owe each 
vendor

Double-click a vendor to 
edit his or her record

From the Vendor menu 
button, you can create 
new vendors or manage 
existing ones

Enter the vendor’s name, 
address and contact 
information in the Address 
Info tab

If this vendor is a 
subcontractor and you will 
be creating a T4A form, 
select this checkbox

Use the Additional Info to 
enter vendor-specific 
information, including the 
vendor type
Vendor List

New Vendor: Additional Info
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Key Term

Vendors

Vendors are any businesses or 
people from whom you buy or 
rent goods or services for your 
business—office supplies, 
phone or computer services, 
or products that you sell. The 
tax agencies that you pay are 
also your vendors. Nearly 
everyone you pay other than 
employees are vendors.

Learn More

To learn more on managing 
your vendors, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Adding vendors
Editing a list entry 
Removing entries from lists
Paying vendors
Setting up payment terms
What if a vendor is also a 

customer?
Synchronizing with ACT! or 

Outlook
Adding Vendors

QuickBooks uses the vendors list to hold information about the people and 
companies you buy goods and services from to run your business; for 
example, this list could include the phone company, your office supplies 
vendor, and utility company. You can add new vendors at any time.

To add a vendor:

From the Lists menu, choose Vendor List.

From the Vendor menu button, click New.

In the Address Info tab, enter all the data that you have about the 
vendor, including his or her name, address, and additional contact 
information.

If you owe this vendor money as of your company’s start date, enter the 
amount in the Opening Balance field. 

Click the Additional Info tab and complete the form, as appropriate.

If you want to add additional fields to the form, click Define Fields to 
customize the form.

Click OK or Next (if you want to enter another vendor).

Tip  Typing in vendor data for hundreds of vendors can be a tedious 
task. If you use Microsoft Outlook or Symantec ACT!, you can import 
your existing vendor information into QuickBooks instead of entering it 
manually. For instructions on importing your vendor data, go to the Find 
window and search for the following help topic: “about contact 
management synchronization”. When you are ready to import your 
vendors, refer to the instructions on Page 17.

Tip  You can also add vendors as you perform your everyday tasks. For 
example, if you enter the name of a new vendor when paying a bill, 
QuickBooks will prompt you to enter information about this vendor. You 
can choose from two quick setup options:

• QuickAdd—Adds just the name to the list without disrupting what you 
are doing. You must add the vendor’s details later.

• Set Up—Opens the New Vendor window so you can set up all of the 
vendor’s details in the Vendor List.
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Subitems are indented 
under the parent item

For inventory parts, the On 
Hand column shows how 
many of each item you 
have in stock

From the Item menu 
button, you can add new 
items or perform activities 
on existing items

Choose the type of item 
you want to create from 
the Type drop-down list

Click Custom Fields to set 
up and fill in custom fields 
that you need for your 
items

Enter the amount you 
want to charge for the 
item here

Associate the item with an 
account here

Choose the sales tax code 
to associate with the item
Item List

New Item
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Key Term

Items

An item is anything that might 
appear as a line item on an 
invoice or a purchase order, 
including subtotals, and 
discounts as well as the 
products and/or services that 
you sell. You enter items on 
your invoices and sales 
receipts. For example, a 
writing consultant might set up 
one item for editing services 
with an hourly rate, and 
another item for writing 
services with a different hourly 
rate. On an invoice, the items 
would be entered with the 
number of hours worked as 
the quantity.

While providing a quick means 
of data entry, items also 
handle the behind-the-scenes 
accounting. When you create 
an item, you link it to an 
account; when the item is 
used on a form, it posts an 
entry to that account and 
another to the accounts 
receivable, accounts payable, 
chequing, or other account.

Did You Know?

You can hide an item on the 
item list without deleting it by 
making it inactive. When an 
item is inactive, the 
information associated with 
the item is kept, but 
QuickBooks hides the item 
from the list and you can no 
longer select it from certain 
forms. To make an item 
inactive, select it from the 
Item List, click the Item menu 
button and select Make 
Inactive. To see inactive items 
in the list. click the Show All 
button.
Adding Items

In QuickBooks, an item is anything that your company buys, sells, or resells 
to run your business. Items are your products, services, and things such as 
shipping and handling charges, subtotals and discounts.

On a sales form, when you choose an item from the Item list, QuickBooks 
fills in a description of the line item and calculates its amount for you.

QuickBooks provides twelve different types of items, described in the table 
on page 44. Some items, such as service or inventory part items, help you 
record the services and products your business sells. Other items, such as 
the subtotal or discount item, are used to perform calculations on the 
amounts in a sale.

To add an item:

From the Lists menu, choose Item List.

From the Item menu button, click New.

From the Type drop-down list, choose the type of item you want to 
create. (See table on page 44.)

Enter an item name as you want it to appear on purchase and sales 
forms.

Enter the description that you want to appear on sales forms when you 
use the payment item.

In the Rate field, enter the amount you want to charge for the item.

In the Account field, choose the account that is associated with this 
item. 

In the Sales Tax Code list, select the sales tax code that represents the 
taxes you need to charge on this item. If you do not see the Tax Code 
list, you must turn the sales tax preference on. Refer to “Setting up your 
sales tax” on page 47 for more information on sales tax.

Click OK or Next (if you want to enter another item).

Do you stock and sell items in different units? 

Refer to “Setting up items in different units of measure” on page 45 for 
more information on setting up the items that you buy and sell in different 
units of measure.
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Which Item Type Should I Choose?
QuickBooks provides twelve different types of items to help you fill 
out sales and purchase forms quickly.

Item Type Purpose

Services
Use for services you either charge for or purchase, 
like specialized labour, consulting hours, and 
professional fees.

Inventory part
Use for goods you purchase, track as inventory, and 
resell.

Inventory Assembly Use for goods that you assemble from parts you buy.

Non-inventory part
Use for goods you buy but don't track, like office 
supplies, or materials you buy for a specific job that 
you charge back to your customer.

Fixed asset 

Use for an asset you do not expect to convert to cash 
during one year of normal operations. A fixed asset is 
usually something that is necessary for the operation 
of your business—like a truck, cash register, or 
computer.

Other charge
Use for miscellaneous labour, material, or part 
charges, such as delivery charges, setup fees, and 
service charges.

Subtotal
Use to total all items above it on a form, up to the 
previous subtotal. Useful for applying a percentage 
discount or surcharge to many items.

Group
Use to quickly enter a group of individual items on an 
invoice.

Discount

Use to subtract a percentage or fixed amount from a 
total or subtotal. Do not use this item type for an early 
payment discount; for an early payment discount, use 
the Set Discount feature in the Receive Payments 
window.

Payment
Use to record a partial payment you received at the 
time of the sale. It reduces the amount owed on an 
invoice.
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Learn More

To learn more on working with 
items, go to the Find window 
and type in the following terms 
to search for these help 
topics:

Types of items
Creating items for services
Creating items for non-

inventory parts
Creating items for inventory
Creating subitems
Changing the sales price of 

items
Changing an item’s type
Making an item inactive
Reports about items
units of measure

Did you Know?

When you define different 
units for an item, QuickBooks 
displays the appropriate unit of 
measure on your forms. For 
example, sales forms show an 
item’s selling unit and 
purchasing forms show an 
item’s purchasing unit. You 
cannot show an item’s 
purchasing unit on a sales 
form and vice versa. 

Also, some reports break 
down items by their units of 
measure. The unit that is 
shown depends on the report 
that is being created. For 
example, reports that show 
the total number of items 
you’ve purchased will display 
your items in their purchasing 
unit (if one was defined). 
Reports on sales will display 
items in their sales unit. You 
can change reports to display 
in any unit you want by clicking 
the Modify Report button at 
the top of the report.
Setting up items in different units of measure

In QuickBooks, you can stock items in your inventory in one unit of measure 
and sell them in another. For example, buying soda pop in a case that holds 
12 cans, then selling the cans individually.

To turn on units of measure:

From the Edit menu, choose Preferences.

From the scroll box on the left, select Purchases & Vendors.

On the Company Preferences tab, select “Inventory and purchase orders 
are active” if it isn’t already.

Select “Units of Measure are active”.

To set up items in different units:

You can only set up different units of measure for the following types of 
items: Inventory Part, and Inventory Assembly.

From the Lists menu, choose Item List.

From the Item menu button, choose New. The New Item window opens.

From the Type field, select Inventory Part or Inventory Assembly. 

Click the Units of Measure button. The Define Units of Measure window 
opens.

In the Inventory Unit section, enter the name of the unit that you use to 
stock this item.

If you sell this item in a different unit than how it is stocked:
In the Sales Unit section, clear the Same as Inventory checkbox, then 
define the sales unit.

If you purchase this item in a different unit than how it is stocked:
In the Purchasing Unit section, clear the Same as Inventory checkbox, 
then define the purchasing unit. Typically, businesses purchase and 
stock items in the same unit. 

Click OK, and continue setting up the item.

Caution  Once you have turned on the units of measure preference, you 
cannot turn it back off again. You should only consider activating units 
of measure if you buy, stock and sell in different units.
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Sell items

QuickBooks tracks the sales tax
that you buy and sell in the GST

Invoice

Print the cheque
If you charge your customers sales tax, you will want to turn on sales tax 
tracking in QuickBooks. With this preference turned on, QuickBooks can 
automatically apply the correct sales taxes to sales and purchases, and 
calculate your net tax for a given sales tax reporting period. 

For complete instructions on dealing with sales tax, refer to the in-product 
Help. Go the Find window and search for “collecting and paying sales tax”.

Assign sales tax codes to your items

Buy items

 on the items
 and PST

Enter Bills

Print your GST/PST return
Payable
registers

 and remit to the government

which
QuickBooks
creates by
default
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Key Term

Net Tax

Your net tax is the difference 
between the total amount of 
GST/PST you’ve collected, and 
the total amount of GST/PST 
you’ve paid out (called input 
tax credits). 

Sales Tax Codes 

When you turn on sales tax, 
QuickBooks sets up a list of 
default sales tax codes based 
on the province in which your 
business is located. These 
sales tax codes live in the Tax 
Codes List. You assign these 
codes to the items that you 
sell and buy. QuickBooks uses 
these sales tax codes to 
correctly calculate and record 
your sales tax for you.

Did you know?

Sales tax liabilities 

If you started collecting sales 
tax before you began using 
QuickBooks, you need to enter 
the amount of sales tax that 
you still owe to the government 
as of your QuickBooks start 
date, otherwise you may be 
filing an incorrect GST/PST 
return. For more information 
on updating your sales tax 
liability in QuickBooks, search 
for “entering sales tax liability” 
in the Find window.

Customers with special tax 

status

You can assign sales tax 
codes to customers that have 
a special tax status. For more 
information on this, search for 
“assigning tax codes to 
customers” in the Find 
window. 
Setting up your sales tax

To turn on the sales tax feature: 

From the Edit menu, choose Preferences.

In the Preferences window, go to the scroll box on the left and select 
GST/PST.

Click the Company Preferences tab, and for the question “Do you wish 
to set up taxes”, select Yes. 

Set the preferences for your GST and PST. Here, you can enter your 
business number (for GST), registration number (for PST), and define 
your reporting periods. 

Assigning sales tax codes to the items you sell and buy

QuickBooks uses sales tax codes to keep track of how much GST/PST 
you’ve collected from your customers, and how much you’ve paid out on the 
items you’ve purchased for your business. 

For QuickBooks to know how to tax the items that you buy and sell, you 
need to associate a sales tax code with each item. After you do so, 
QuickBooks can then automatically charge the correct amount of sales tax 
on your sales and purchasing forms, and then calculate your net tax when it 
comes time to remit your sales tax to the government.

To assign sales tax codes to your items: 

From the Lists menu, choose Item List.

Choose New from the Item menu button.

If you purchase the item:
In the Purchase Information section, go to the Purch Tax Code field and 
select the correct tax code for this item. If you don’t see the Purchase 
Information section, click one of these checkboxes (I purchase... This 
item is purchased... or This service is performed by a...).

If you sell the item:
In the Sales Tax Code field, select the correct tax code for this item. 

Tip  Intuit recommends that you set up your sales tax in QuickBooks by 
completing the EasyStep Interview. If you skip the EasyStep Interview 
when setting up your company file, you will have to turn on the sales 
tax preference yourself and assign sales tax codes to the items you 
sell and buy. To set up your sales tax, refer to the instructions below 
(only if you skipped the EasyStep Interview). 
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Remitting your GST/PST return to the government

When you are registered for GST/PST, you have to file a GST/PST return for each of your reporting periods. 
This process is easy with QuickBooks. When you set up sales tax, QuickBooks automatically calculates your 
net tax and reports it on your return for you. 

To send your GST/PST return to the government:

When you complete a sales tax return in QuickBooks, the transactions included in the return are marked as 
“filed” so that QuickBooks knows which transactions to include in future GST/PST returns. We recommend 
that you back up your company file before filing your sales tax. That way, if you need to go back to a state 
prior to the sales tax return, you are able to do so.

From the Vendors menu, choose Sales Tax, then File Sales Tax. The File Sales Tax window opens. 

In “Show Sales Tax through”, select the last day of the reporting period for which you are filing, then 
select the government agency. 

If you want QuickBooks to print a cheque for you, click To be printed. If you want to write the cheque 
yourself, click Assign cheque no. 

Click Next. Your sales tax return is opened. 

Review your return. You can adjust the amounts with the exception of lines 103 and 106. Click the 
Adjust button to adjust these two lines.

Scroll to the bottom of the return, and click Next. Your return is now ready to send to the government. 
Click Print.

Write your cheque to the government, or if QuickBooks is printing the cheque for you, follow the steps 
below:
a. From the File menu, select Print Forms, then choose Cheques. 
b. Select the cheque(s) that you want to print and click OK. 
c. Set your printing options, then click Print. 

For complete instructions on dealing with sales tax, refer to the in-product Help. Go the Find window and 
search for “collecting and paying sales tax”.

What if I get a refund?

If you are receiving a refund, QuickBooks automatically creates an invoice for the Receiver General or 
Minister of Finance. When you receive the cheque from the government, receive the payment against the 
invoice.

Tip  You can see what your net sales tax is any time by creating the GST & PST Liability reports. To create 
these reports, go to the Reports menu, select Vendors & Payables, and choose GST or PST Liability. 
Make sure the date is set to the remittance period for which you are filing and then generate the report 
again.
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Paying employees is a big responsibility. You have to keep track of hours, 
salaries and wages, social insurance numbers, dates of birth, current tax 
rates and forms, vacation pay and sick time, and bonuses, as well as your 
liability payments to the government and benefit agencies. 

QuickBooks Payroll service

With a subscription to QuickBooks Payroll, you have access to several 
features and services to help you manage your own payroll quickly and 
easily, thus saving you time. Without QuickBooks Payroll, you still have 
access to some payroll features in QuickBooks, but you will not be able to 
create pay cheques or enter year-to-date information for your employees, 
and QuickBooks will not calculate payroll amounts for you.

As a QuickBooks Payroll subscriber, you never have to stress about getting 
updated payroll tax information from the CRA again. You will automatically 
receive updated payroll tax tables whenever the Federal or Provincial 
government changes the tax laws. In addition, you receive QuickBooks 
software updates that keep your software investment current. Software 
updates include software improvements, new features and help updates. 

How do I subscribe to QuickBooks Payroll?

Subscribing to QuickBooks Payroll is easy. Go to the Employees menu, 
choose Set Up QuickBooks Payroll, then select Sign Up Now. 

To update your payroll tax tables:

Open QuickBooks and make sure you are connected to the Internet.

From the File menu, choose Update QuickBooks. 

Click Update Now. 

Select the updates you want to download, then click Get Updates.

When the update is done, click Close and restart your computer.

You can see what tax table version you currently have by going to the 
Employees menu and selecting “Set Up QuickBooks Payroll”, then 
“About Payroll”.

Tip  You can have QuickBooks automatically download new tax tables 
when they become available by turning on the Automatic Update 
feature. Refer to the in-product Help for more information. Go to the 
Find window, and search for “automatic update”.



Setting Up Your Payroll

Key Terms

Payroll Liabilities account

The Payroll Liabilities account 
tracks taxes that you deduct 
from employees' pay cheques 
and holds them temporarily 
until you remit them to the 
government. These include 
income tax, Canada or Quebec 
Pension Plan contributions, 
and Employment Insurance 
premiums. 

QuickBooks automatically 
adds this account to your chart 
of accounts. When you create 
payroll items, QuickBooks 
automatically assigns some of 
them to the Payroll Liabilities 
account by default (but you 
can change this assignment if 
you prefer to assign them to a 
different account). When you 
change a payroll item to track 
to a different account, the 
change affects all (previous 
and current) payroll cheques 
that have the newly-changed 
payroll item attached to it.

Payroll Expenses account

The Payroll Expenses account 
tracks payroll items that are an 
expense to your company. 
These include salaries, wages, 
bonuses, commissions, and 
the company-paid portion of 
taxes such as Employment 
Insurance.

QuickBooks automatically 
adds this account to your chart 
of accounts. When you create 
payroll items, QuickBooks 
automatically assigns some of 
them to the Payroll Expenses 
account by default (but you 
can change this assignment if 
you prefer to assign them to a 
different account).
Adding Payroll Items

You add payroll items to pay cheques the same way you add items to 
invoices. Payroll items track amounts such as wages you pay and taxes you 
deduct from pay cheques. There are payroll items for compensation, taxes, 
other additions and deductions, and employer-paid expenses. You can 
assign these payroll items to different accounts as needed.

By default, QuickBooks creates payroll items for payroll taxes. To fully track 
your payroll, you will probably need to add more payroll items to the list. For 
example, you can add payroll items for hourly wages, salaries, commission, 
and bonuses; government taxes and deductions; employee deductions of 
any kind (such as RSP contributions); additions (such as an automobile 
allowance); commissions; and company-paid expenses (such as company-
paid health insurance).

The payroll item wizard guides you through setting up taxes and common 
payroll items that many companies need to do payroll. It automatically sets 
up the common items to calculate taxes correctly (as long as your 
QuickBooks payroll tax table is up to date).

To create a payroll item:

From the Employees menu, choose Payroll Item List.

From the Payroll Item menu button, choose New. The payroll item wizard 
opens.

Choose the type of payroll item you want to create.

Click Next and answer the questions on each slide of the wizard.

Use this payroll item To track

Wage
Money you pay to employees for salaries, hourly wages, 
commissions, bonuses, or advances.

Addition
Money you pay to an employee that is not a direct result 
of their work, such as a profit-sharing payout.

Deduction
Money you deduct from your employee other than taxes, 
such as union dues, and employee purchases.

Company Contribution
Company-paid benefits for your employees such as 
pension plans or dental benefits.

Other Tax
Miscellaneous taxes (company or employee paid) based 
on an employees wages such as Provincial Health Tax.
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Employee Checklist

General Information Know th

Compensation

If the em
employe
compens
timing a

Benefits
Know wh
insuranc

Other payments and 
deductions

Know wh
support 

Payroll taxes
Know wh
expense
enter the

Sick and vacation time
If your co
remainin

Enter employee 
personal information 
including SIN, date 
hired, birth date, etc.

Enter employee wage 
information (are they 
on a salary or paid by 
the hour)

Enter employee 
benefits and 
deductions including 
payments to a 
retirement plan or 
union, company-paid 
benefits such as a 
dental plan, or 
additions for 
reimbursement for 
travel expenses

Enter employee 
government tax 
information including 
income tax, EI, CPP, 
and TD1 information
e employee’s legal name and address (for tax forms), Social Insurance Number, date of birth.

ployee is paid according to hours worked, know his or her hourly rate or rates. If the 
e is paid a fixed amount, know the current annual salary. Know any other types of regular 
ation, such as bonuses or commission. Know how often the employee is paid (as the 

ffects tax calculations on pay cheques).

ich company benefits affect the employee’s pay cheque (for example, employee-paid 
e, taxable company-paid benefits, any benefit calculated as a percentage of gross).

ether the employee has any other payments or deductions, such as union dues or child 
garnishments.

ich payroll taxes the employee is subject to and whether the tax is deducted or is an 
 to the company. For income tax withholding, have the employee’s TD1 form so you can 
 information from the form into QuickBooks.

mpany offers paid sick time and vacation pay, know how much of each the employee has 
g, and how it accrues (at beginning of the year or with each pay cheque).

New Employee: Payroll Info tab

Set up how the 
employee accrues 
time for sick days 
and overtime

Enter how much vacation pay the 
employee has accrued and what has 
been paid out, how it is paid out, the 
percentage to calculate (e.g., 4% or 
6%) and which payroll items you want 
to use to calculate the vacation pay 

Enter direct deposit 
information if you are using 
the Direct Deposit service 
of QuickBooks Payroll
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Key Term

Employees

If you need help determining 
whether an individual is an 
employee or self employed, 
refer to the CRA Web site 
(www.cra-arc.gc.ca) for 
guidelines. For more 
information on managing 
subcontractors, refer to the in-
product Help. Go to the Find 
window and search for 
“tracking work performed by 
subcontractors”.

Did you Know?

Information that is common to 
most of your employees can 
be set up as a default. That 
way, when you go to set up an 
employee, some of the payroll 
settings are already set up for 
you. For more information on 
setting employee defaults, 
refer to the in-product Help. Go 
to the Find window and search 
for “entering common 
employee information”.

Learn More

To learn more on Managing 
Employees, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Setting up employee 
information

Setting up an employee’s 
payroll information

Setting up employees for 
direct deposit

Entering sick time and 
vacation pay

Entering year-to-date 
amounts for an employee

Releasing an employee
Setting up Employees

To process pay cheques and prepare tax documents for your employees, 
you need to enter specific information about each of your employees in 
QuickBooks. Refer to the Employee Checklist on page 52 for a list of 
information to gather.

Note: If you administered payroll before using QuickBooks, you must enter your 
previous payroll transactions into QuickBooks. For more information on entering 
year-to-date amounts for your employees, refer to Page 58.

To set up an employee’s personal information: 

From the Lists menu, choose Employee List.

From the Employees menu button, click New. The New Employee window 
opens. 

Complete the Address Info tab. Enter the employee’s date of birth.

On the Additional Info tab, define custom fields to store other 
information such as the name of spouse.

To set up an employee’s payroll information:

Open the New Employee window as described in the steps above. Click 
the Payroll Info tab.

In the Earnings section, set up the employee’s wage information. 

Under “Item Name”, select a salary or hourly payroll item, then under 
“Hourly/Annual Rate”, enter the amount you pay him or her annually or 
hourly. In Pay Period field, select how often you pay this employee.

Select “Use time data to create pay cheques” if you use QuickBooks to 
track your employee’s time and pay cheques based on this time. 

In the Additions, Deductions, and Company Contributions section, set 
up any employee benefits and other deductions (except for taxes) that 
you take from his or her pay cheque.

Click the Payroll Taxes button to enter information from the employee’s 
TD1 form, and review the income tax, Canada Pension Plan/Quebec 
Pension Plan, EI and other payroll taxes he or she might have to pay.

Click the Accrual Hours button to set up how much time an employee 
has available, and how much he or she has accrued this year.

Click the Vacation Pay button to set up how much vacation pay the 
employee has available and how much he or she earns.

Click the Direct Deposit button to set up direct deposit information. 
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QuickBooks draws 
the cheques from this 
account

Specify a cheque 
date and pay period 
for the pay cheque 
you create

QuickBooks creates a 
pay cheque for each 
employee marked 
with a check mark

To enter hours 
worked, 
commissions, 
bonuses or other 
variations from pay 
period to pay 
period, select this 

To prevent sick and 
vacation hours from 
accruing from this 
pay cheque (for 
example, on a bonus 
or commission pay 
cheque) select this 
checkbox

If an addition, 
deduction, or 
company 
contribution is based 
on quantity, enter 
the quantity here

This area shows 
company-paid taxes 
and contributions. 
These amounts do 
not affect the amount 
of the pay cheque
Preview pay cheque

Employee Summary 
shows the payroll 
amounts that will be 
printed on the voucher 
of the pay cheque



Setting Up Your Payroll

Did You Know?

QuickBooks Payroll service

QuickBooks Payroll is a service 
that provides tools, tables, 
and forms to help you run your 
payroll, pay your payroll taxes, 
prepare your federal tax forms, 
and file your T4s electronically. 
With QuickBooks Payroll 
Service, managing your payroll 
will never be easier.

QuickBooks Payroll also offers 
Direct Deposit of employee pay 
cheques for a small additional 
fee. For more information 
about payroll services, go to 
the Find window and type in 
“direct deposit”.

Learn More

To learn more on Managing 
Employees, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Entering wage and salary 
information

Printing pay cheques
Using a payroll service
Paying payroll taxes and 

other liabilities
Preparing and filing payroll 

tax forms
QuickBooks payroll service
Previewing and adjusting 

pay cheques
Calculation looks wrong
Reports about payroll
Paying Employees

Before you begin creating pay cheques to your employees, be sure that your 
payroll is set up completely and correctly in QuickBooks. We strongly 
recommend that you read the entire Payroll and Employees chapter in the 
QuickBooks User Guide. To read this guide, go to the Help menu, select 
Guides, and then QuickBooks User Guide.

Note: Some payroll tasks (e.g., creating pay cheques) require you to be subscribed 
to QuickBooks Payroll. QuickBooks cannot calculate payroll amounts unless you 
sign up for the payroll service. For information about the payroll service for 
QuickBooks, go to the Employees menu in QuickBooks, choose Set Up QuickBooks 
Payroll Service, and then About Payroll Services. Click the Info button.

To print pay cheques:

From the Employees menu, choose Pay Employees.

Choose the account from which you want to create your pay cheques.

Choose whether the pay cheques are to be printed, handwritten, or 
direct deposited.

In the Cheque field, enter the date you want to appear on the cheque. In 
the Pay Period Ends field, enter the last day of the pay period you are 
paying.

Select the employee you want to pay by clicking in the column to the left 
of the employee’s name.

If you want to preview or modify your pay cheques, click “Enter hours and 
preview cheque before creating.” If you don’t want to preview the pay 
cheques, click “Create cheque without preview using hours below and 
last quantities.”

Click Create.

If you chose to preview pay cheques before creating them, QuickBooks 
displays the Preview Pay cheque window, starting with the first employee 
you are paying. Make any modifications to the cheque and click Create.

Click Print Pay cheques.

Tip  You should always use the Pay Employees window to record pay 
cheques. QuickBooks’ payroll tax forms and reports take their data 
from transactions recorded using payroll items. These transactions are 
only created when you create a pay cheque in the Pay Employees 
window. If you don’t use this window to pay employees, your payroll tax 
forms and reports will not be complete.
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When it comes time to pay your payroll liabilities, QuickBooks tracks how 
much you owe and to whom, allows you to choose which liability you want to 
pay, creates the cheques for you, and helps you fill out the monthly forms. 

Paying your Payroll Liabilities

Most businesses must send a cheque to the CRA for the last month’s 
payroll deductions by the 15th of the current month. Check with the CRA or 
your accountant if you are unsure of when you need to remit your payroll 
liabilities.

To pay your payroll liabilities:

From the Employees menu, choose Process Payroll Liabilities and then 
Pay Payroll Liabilities.

Select the date range of the payroll period for which you are paying your 
liabilities and click OK. The Pay Liabilities window opens.

Mark the payroll liabilities that you are paying this period. 

Review all other settings, and make any adjustments as necessary and 
click Create.

To print the liability cheques, go to the File menu, choose Print Forms, 
then select Print Cheques. (Make sure the same bank account you used 
to create the cheques is selected.) 

To fill out your PD7A or TPZ-1015 form:

When you send in your monthly payments to the CRA, you must also submit 
a PD7A form or TPZ-1015 form if you live in Quebec.

From the Reports menu, choose Employees & Payroll, then select PD7A 
Report or Quebec Remittance Report (TPZ-1015).

Change the default dates to show the correct payroll deductions period.

Click OK to generate the report again. 

Use the information on the report to fill in your monthly forms.
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Key term

Payroll Liabilities

Payroll liabilities are the 
amounts that you have 
deducted from your 
employees’ pay cheques but 
not yet passed on to the 
government or other agencies 
for such things as income tax, 
EI premiums and CPP.

QuickBooks tracks the amount 
you owe for your payroll 
liabilities in an account called 
“Payroll Liabilities” which is 
automatically created. Each 
time you create a pay cheque, 
QuickBooks increases the 
balance of this liability 
account, and when you pay 
your payroll liabilities, the 
balance of this account is 
decreased.

Learn More

To learn more on Managing 
Payroll, go to the Find window 
and type in the following terms 
to search for these help 
topics:

Preparing and filing payroll 
forms

Setting up and using 
QuickBooks payroll

Adjusting your payroll 
liabilities

Creating a PD7A form
Verifying payroll liabilities
Recording a payroll liability 

refund cheque
How QuickBooks calculates 

payroll liabilities
Paying payroll taxes and 

other liabilities
Preparing and filing payroll 

tax forms
Preparing T4 Slips for your Employees

T4 slips are end-of-year payroll forms that show an employee’s wages and 
payroll deductions for the past year. You must create these slips for your 
employees and the government in January or February. (In Quebec, you also 
need to create Relevé 1 slips.)

To create and print T4 and Relevé 1 slips:

From the Employees menu, choose Process T4s or Process Relevé 1s.

You cannot print slips until you review them. Mark the employees whose 
tax slips you want to review, and click Review T4 or Review RL-1.

Review the slip, then click Next to approve it. When you are done 
reviewing your employees’ slips, click OK.

You are now ready to print your slips. Click the Print T4 or Print RL-1 
button to print the form. 

You can also file your T4s electronically by clicking the “E-file T4” button. 
When you E-file your T4s, QuickBooks automatically creates and sends 
your T4s and sends a T4 Summary. You know instantly whether CRA 
accepted or rejected your submission. Also, QuickBooks records your 
E-file submission ID for future reference. 

Choose whether you are printing your T4 and RL-1 slips on blank paper 
or pre-printed blank forms that you can get from the government. 

If you are printing the slips, select the type of T4 or RL-1 slip you want to 
print and who you are printing it for.

• Canada Customs and Revenue Agency Copies: select if you are 
printing slips to send to the CRA.

• Employer Copies: select if you are printing slips for your records.
• Employee Copies: select if you are printing slips to give to your 

employees. Employee slips do not include your company’s business 
number as required by the CRA.

• Multipart (Impact) forms: select to print one slip per employee on a 
multipart blank slip. You must choose this option if you have a 
continuous-feed (dot matrix) printer. 

Click Print.

If you mail your T4 slips to the government, you also need to fill out a T4 
Summary form. A T4 Summary form summarizes the individual T4 slips you 
created. QuickBooks has the T4 Summary report to help you with this task. 
To create this report, go to the Reports menu, select Employees & Payroll, 
then T4 Summary. 
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If you have been paying your employees prior to using QuickBooks, you 
must enter a summary of 

• the amount of each employee’s earnings so far this year and the amounts 
that you deducted from his or her earnings, and

• the amount of payroll deductions that you paid to the government so far 
this year.

You must enter these year-to-date summaries so that QuickBooks can 
correctly calculate your payroll end-of-year tax information (T4, Relevé 1 
slips and PD7A forms, for example).

Note: You must be subscribed to QuickBooks Payroll to enter YTD summaries. 

To enter Year-to-date Summaries for each employee:

Summarize your payroll transactions for each employee from January 1 
to the date that you subscribed to QuickBooks Payroll.

From the Employees menu, choose Set Up YTD Amounts. The YTD 
wizard opens.

Follow the on-screen instructions until you get to the Employee summary 
information screen. Select an employee from the list and click Enter 
Summary. The YTD Adjustment window opens.

Enter the details of the year-to-date payroll summary for this employee.

Click OK, and select the next employee . 

Click Leave when you are done, or if you need to enter prior payroll 
liability payments, click Next and refer to the steps below.

To learn more about entering YTD information, refer to the in--product Help. 
Go to the Find window and search for “entering YTD amounts”. 

To enter prior payroll deductions you’ve remitted to the government:

Open the YTD wizard as explained in the steps above.

Follow the on-screen instructions until you get to the Enter prior 
payments screen. 

Click the Create Payment button to enter a summary of all the payments 
you’ve made to the government from January 1 to the date you 
subscribed to QuickBooks Payroll.

How do I know which accounts are affected? Click the Accounts Affected 
button to update the balance of your bank account and/or payroll 
liabilities account with this payroll YTD entry. If your account balances 
are already correct, select “Do not affect accounts”. For more details on 
this, click the Help button on the Affect Accounts window.
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Keyboard Shortcuts

General Key

To start QuickBooks without a 
company file

Ctrl + 
doubleclick

To suppress the desktop windows
(at Open Company window)

Alt
(while 
opening)

Display information about 
QuickBooks

F2

Cancel Esc

Record (when black border is 
around OK, Next, or Previous 
button)

Record (always) Ctrl + 

Dates Key

Next day + (plus key)

Previous day - (minus key)

Today T

First day of the Week W

Last day of the weeK K

First day of the Month M

Last day of the montH H

First day of the Year Y

Last day of the yeaR R

Date calendar
Alt + down 
arrow
Editing Key

Edit transaction selected in 
register

Ctrl + E

Delete character to right of 
insertion point

Del

Delete character to left of 
insertion point

Backspace

Delete line from detail area Ctrl + Del

Insert line in detail area Ctrl + Ins

Cut selected characters Ctrl + X

Copy selected characters Ctrl + C

Paste cut or copied characters Ctrl + V

Increase cheque or other form 
number by one

+ (plus key)

Decrease cheque or other form 
number by

- (minus key)

Undo changes made in field Ctrl + Z

Help window Key

Display Help in context F1

Select next option or topic Tab

Select previous option or topic Shift + Tab

Display selected topic

Close popup box Esc

Close Help window Esc
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Activity Key

Account list, display Ctrl + A

Cheque, write Ctrl + W

Copy transaction in register Ctrl + O

Customer:Job list, display Ctrl + J

Delete cheque, invoice, 
transaction, or item from list

Ctrl + D

Edit lists or registers Ctrl + E

QuickFill and Recall (type first 
few letters of name and press 
Tab, name fills in)

abc Tab

Find transaction Ctrl + F

Go to register of transfer account Ctrl + G

Help in context, display F1

History of A/R or A/P transaction Ctrl + H

Invoice, create Ctrl + I

List (for current field), display Ctrl + L

Memorize transaction or report Ctrl + M

Memorized transaction list, display Ctrl + T

New invoice, bill, cheque or list 
item

Ctrl + N

Paste copied transaction 
in register

Ctrl + V

Print Ctrl + P

QuickZoom on report

QuickReport on transaction or 
list item

Ctrl + Q

Register, display Ctrl + R

Show list Ctrl + S

Use list item Ctrl + U

Transaction journal, display Ctrl + Y

Moving around a window Key

Next field Tab

Previous field Shift + Tab

Report column to the right Right arrow

Report column to the left Left arrow

Beginning of current field Home

End of current field End

Line below in detail area or 
on report

Down arrow

Line above in detail area or 
on report

Up arrow

Down one screen Page Down

Up one screen Page Up

Next word in field Ctrl + 

Previous word in field Ctrl + 

First item on list or previous 
month in register

Ctrl + Page 
Up

Last item on list or next 
month in register

Ctrl + Page 
Down

Close active window
Esc or Ctrl + 
F4
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